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 Introduction to the Module

CAD is the use of computer-based software to aid in design processes. CAD software 

is frequently used by different types of engineers and designers. CAD software can be used to 

create two-dimensional (2-D) drawings or three-dimensional (3-D) models. The purpose of 

CAD is to optimize and streamline the designer's workflow, increase productivity, improve 

the quality and level of detail in the design, improve documentation communications and 

often contribute toward a manufacturing design database. CAD software outputs come in the 

form of electronic files, which are then used accordingly for manufacturing processes. CAD 

is often used in tandem with digitized manufacturing processes. CAD/CAM (computer-aided 

design/computer-aided manufacturing) is software used to design products such as electronic 

circuit boards in computers and other devices

This module is designed to meet the industry requirement under the irrigation and drainage 

occupational standard, particularly for the unit of competency: Perform CAD Operation.

. 

https://www.techtarget.com/whatis/definition/3-D-three-dimensions-or-three-dimensional
https://www.techtarget.com/whatis/definition/CAD-CAM-computer-aided-design-computer-aided-manufacturing
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Module unit

 drawing requirements

 key features of CAD software

 software and set up for drawing work

 basic drawing elements

 CAD operations 

Learning objectives of the Module. At the end of this session, the students will able to:

 Confirm drawing requirements

 Identify key features of CAD software

 Access software and set up for drawing work

 Produce basic drawing elements

 Perform CAD operations 

Module Learning Instructions: 

1. Read the specific objectives of this Learning Guide. Follow the instructions described 

below.

2. Read the information written in the information Sheets

3. Accomplish the Self-checks 

4. Perform Operation Sheets

5. Do the “LAP test”

Unit one: Drawing Requirements
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This learning unit is developed to provide the trainees the necessary information regarding the 

following content coverage and topics:

 Purpose, scope, information and presentation of drawing requirement

 work requirement 

 equipment and software

This unit will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to:

 Confirm purpose, scope, information and presentation of drawing requirement

 Identify work requirement 

 Identify equipment and software

1.1. PURPOSE, SCOPE, INFORMATION AND PRESENTATION OF DRAWING 

REQUIREMENT

1.1.1 Introduction  

Computer-aided design is used in a wide variety of professions. CAD software is used 

heavily within various architecture, arts and engineering projects. CAD use cases are specific 

to industry and job functions. Professions that use CAD tools include, but are not limited to: 

Architects, Engineers, City planners, Graphic designers, Animation illustrators, Drafters, 

Fashion designers, Interior designers and Exterior designers

1.1.2. Purpose of Presentation Drawing

Purpose The purpose of these requirements is to ensure that plans and drawings submitted to 

the facilities engineer are complete and contain the required level of detail. These 

requirements cover preparing plans and drawings associated with excavations (including 

ground disturbance activities) and related permits and utility location requirements. They 

apply to persons responsible for those preparing those plans and drawings: the project 

manager (PM) and field construction manager (FCM) and the utility locator.

1.2.3 Requirements of Engineering Drawings

Engineering drawings need to communicate information that is legally binding by providing a 

specification. Engineering drawings therefore need to meet the following requirements:

https://en.wikipedia.org/wiki/Engineering_drawing
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 Engineering drawings should be unambiguous and clear. For any part of a 

component there must be only one interpretation. If there is more than one 

interpretation or indeed there is doubt or fuzziness within the one 

interpretation, the drawing is incomplete because it will not be a true 

specification.

o The drawing must be complete. The content of an engineering 

drawing must provide all the information for that stage of its 

manufacture. There may be several drawings for several phases of 

manufacture, e.g. raw shape, bent shape and heat-treated. Although 

each drawing should be complete in its own right, it may rely on other 

drawings for complete specification, e.g., detailed drawings and 

assembly drawings.

o The drawing must be suitable for duplication. It is a specification 

which needs to be communicated. The information may be 

communicated electronically or in a hard copy format. The drawing 

needs to be of a suitable scale for duplicating and of a sufficient scale 

such that if is micro-copied it can be suitable magnified without loss 

of quality.

o Drawings must be language-independent. Words on a drawing should 

only be used within the title block or where information of a non-

graphical form needs to be given. Thus, there is a trend within ISO to 

use symbology in place of words.

o Drawings need to conform to standards. The 'highest' standards are the 

ISO ones that are applicable worldwide. Alternatively, standards 

applicable within countries may be used. Company standards are often 

produced for very specific industries.

1.2 WORK REQUIREMENT 

state the requirement clearly, concisely and logically in functional and performance terms 

unless specific technical requirements are needed for goods, state what the item will be used 

for 
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� Contain enough information for offers to decide and cost the goods or services 

they will offer and at what level of quality 

� Permit offered goods or services to be evaluated against defined criteria by 

examination, trial, test or documentation

� Provide equal opportunity for all potential suppliers to offer goods or services 

which satisfies the needs of the user, including goods or services incorporating 

alternative solutions 

� Form the fundamental basis of the contract between buyer and seller not over-

specify requirements

� Not contain features that directly or indirectly discriminate against people with 

disability, but allows optimal access and inclusion

� Specifications are agreed upon defined requirements for a product.

� Specifications are a type of Standard defined by a governing body. 

� Specifications may have embedded drawings but may focus more on text.

1.2.1 CAD Operator Responsibilities:

 Interpreting project briefs and meeting with clients, engineers, and architects to ensure 

all blueprints and technical drawings are completed to specifications.

 Producing rough sketches and using CAD software to prepare detailed drawings, plans, 

and blueprints.

 Visiting sites to gather information, and determine limitations and feasibility of designs.

 Updating software, drawings, and other documents.

 Remaining professional when feedback is delivered, and implementing any changes to 

drafts as soon as possible.

 Ensuring drawings are compliant with building regulations and engineering principles.

 Communicating potential design issues to engineers and architects.

 Conducting research when required.

1.2.2 CAD Operator Requirements:

 Associate's degree in drafting or similar.

 Additional courses in CAD software.
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 Practical experience with CAD software.

 Knowledge of engineering and construction.

 A completed apprenticeship would be advantageous.

 Strong communication skills and attention to detail.

 Superb work ethic and ability to accept feedback.

                   There are six types of specifications. 

            1.2.1 Functional specifications:

These are specifications that define the function, duty or role of the goods or services. 

It nominates what the goods or services are broadly required to do. Functional 

specifications define the task or desired result by focusing on what is to be achieved rather 

than how it is to be done. They do not describe the method of achieving the intended result. 

This enables suppliers to provide solutions to defined problems. For example, a 

specification for “an accessible device capable of conveying children from their school to 

their homes” does not limit responses to bus operators alone.

1.2.2 Performance specifications:

 These are specifications that define the purpose of the goods or services in terms of how 

effectively it will perform, that is, in capability or performance terms. Performance is a 

logical extension of function. Performance specifications define the task or desired result by 

focusing on what is to be achieved. They do not describe the method of achieving the 

desired result. This enables suppliers to provide solutions to defined problems. For example, 

a specification could be written: “An accessible device is required to convey at least 30 

children every afternoon of the school week from their school in a safe manner to their 

homes within a radius of the school of 15 kilometers. 

1.2.3 Technical specifications: 

These are specifications that define the technical and physical characteristics and/or 

measurements of a product, such as physical aspects (for example, dimensions, color, 

surface finish), design details, material properties, energy requirements, processes, 

maintenance requirements and operational requirements. They are used when functional and 

performance characteristics are insufficient to define the requirement.

                1.2.4 Design or Product Specification 
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A design or product specification describes the key points or requirements for a final design 

not how to achieve it.

            1.2.5 Application Specification 

Application Specifications provide a sequential presentation of functions that need to be 

carried out in order to achieve a goal. The key difference between Performance and 

Application Specifications is that Performance specifications define a goal with no guidance 

on how this is achieved.  Whereas Application Specifications define a step by step set of 

instructions which lead to a common goal.

1.3. EQUIPMENT AND SOFTWARE

There are a variety of engineering and design jobs that use CAD (computer-aided design 

software).We often get asked what CAD software companies use. As a busy staffing agency 

for engineers, and designers we know it depends on the particular industry a company is in. 

Interested in learning about the best CAD software for engineers, designers, and drafters 

Keep reading. We list CAD software packages you should consider learning, some of their 

features, potential career paths, and the industries that create jobs for them.  

Popular types of CAD software companies use include SolidWorks, Inventor, Revit, 

AutoCAD, Civil 3D, MicroStation, CATIA, Creo, and Siemens NX

 SolidWorks  

As a popular mechanical design software with a large community of users, employers are 

frequently seeking job seekers with SolidWorks experience.  This 3D modeling CAD 

software is used heavily in the mechanical engineering and design industries. It is the 

industry standard for product development.

Some features including:

 Product design simulation

 3D solid modeling

 Product data management

 Cost estimation, manufacturability checks

 Created with ease of use in mind

 Used by mechanical and electrical engineering departments

 AutoCAD  

https://en.wikipedia.org/wiki/Computer-aided_design
https://en.wikipedia.org/wiki/Computer-aided_design
https://www.apollotechnical.com/it-engineering-recruitment/engineering-staffing-agency/
https://www.apollotechnical.com/it-engineering-recruitment/engineering-staffing-agency/
https://www.ponoko.com/blog/how-to-make/how-to-design-an-industrial-product/
https://www.solidworks.com/
https://www.autodesk.com/products/autocad/features
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One of the oldest and most used CAD software for 2D / 3D drafting & design. It has the 

ability to create blueprints, equipment layouts, section planes, model documentation, and 

more. Learning AutoCAD and additional 3D CAD software is a recipe for success.

Some features including:

 2D drawing, drafting, and annotation

 Extended workflows

 Xrefs and block palettes

 Dynamic blocks

 3D Mesh, solid and surface modeling

Jobs that use AutoCAD CAD software

 Architects, Architectural designer, and drafter

 Electrical engineer, design and drafter

 Electronics engineer, design and drafter

 Plumbing designer, HVAC designer, MEP designer

 Interior designer

 Industrial engineer

 Manufacturing engineer

 Mechanical engineer, design and drafter

 Structural engineer, designer, and drafter

Industries Use AutoCAD

 Aerospace & Aviation

 Consumer products

 Manufacturing

 Medical Device

 Industrial products

 Oil & Gas

 Civil, Structural, MEP
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Figure 1 Equipment
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Self-Check -1

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page:

I. choose the correct answer for given alternative (5 point each)

1.Which one of the following is provide a sequential presentation of functions that need to be 

carried out in order to achieve a goal.

        A, production specification B, application specification C, specification of lettering 

2. Which one of the following is specifications that define the purpose of the goods or 

services in terms of how effectively it will perform, that is, in capability or 

performance terms

A, Performance specifications      B, Technical specifications    C, Application Specification

3. Which one of the following is describes the key points or requirements for a final design 

not how to achieve it.

     A Product Specification    B, production specification     C, application specification

II.   Answer the following questions (3point each)

1. What is the difference between Performance specifications and Application 

specifications

2. List at least three types of specifications

3. Explain types of specifications

III. Say true or false (5 point each)

1. Technical and physical characteristics and/or measurements of a product, such as 

physical aspects (for example, dimensions, color, surface finish), design details, etc.
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2. Performance specifications define the task or desired result by focusing on what is to be 

achieved

3. Uses of an AUTO is drawing by hand much quicker than drawing by cad. 

Unit Two: Key Features of Cad Software

This learning unit is developed to provide the trainees the necessary information regarding the 

following content coverage and topics:

 CAD software and their key futures 

 2-D drawings, 3-D models in CAD processes 

 Peripheral equipment and software programs compatibility 

This unit will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to:

  Describing CAD software and their key futures 

 Identifying 2-D drawings, 3-D models in CAD processes 

 Identifying peripheral equipment and software programs compatibility 

:

   2.1 CAD SOFTWARE AND THEIR KEY FUTURES 

2.1.1 Purpose of CAD software

 Computer-aided design software (CAD software) refers to a type of software program used 

by designers and engineers to create two-dimensional and three-dimensional models of 

physical components. CAD software has all but replaced the T-squares and protractors used 

by the designers of yesterday in a process known as manual drafting, the traditional ''pencil 

on paper'' approach to engineering and design. may include but not limited to: AutoCAD, 

Inventor, Revit, Solid works, ProSteel, XSteel and starting AutoCAD.

   

 2.1.2   Key features CAD software

The key features of CAD software that you should be aware of.



Version -1Page 17 of 66 Ministry of Labor and 
Skills

Author/Copyright

Preform CAD operation

August, 2022

1. 3D Presentations

Visualizing your layouts can be challenging especially if you’re forced to look at it on a flat 

surface. But with CAD software, you can see your designs come to life through 3D rendering. 

Currently, there are limited tools that allow you to model your layouts in 3D. Thus, it is 

important that you keep an eye out for this feature during your selection. Through CAD 

software, you can present your designs in 3D. This lets you visualize your layouts in a more 

detailed and comprehensible view. This gives you a clearer idea of how your designs will 

look like in reality.

2. Smart tools

Smart or automated tools are one of the general features of CAD software. It simplifies the 

creation process by automating certain tasks. This may include shape and dimension 

manipulation, design configurations, alignments, accuracy, and precision check, and more 

Software with 3D rendering can also automatically compute measurements and angles in 

your layouts. This ensures that your models have no issues or setbacks once the actual 

building process starts. These tools make designing easier, faster, and more reliable compared 

to the manual drafting process. It lets you focus on conceptualizing ideas and visions, while 

the software takes charge of the necessary details to make sure that your ideas can work 

smoothly.

3. Preset models

Like other designing and creation software, CAD software can also offer preset models for 

your layouts and designs. This serves as your template or reference for your project. In this 

way, you can quickly create blueprints and models without needing to start from scratch. 

Others have a library of premade models of certain parts like bolts and nuts, or essential 

layout features like doors and shelves. You can then easily insert these premade parts into 

your designs. This reduces time spent on worrying about smaller details in your designs while 

also reducing chances of making mistakes.

4. Collaboration tools
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One of the biggest perks of digitization is the easy and convenient way to share and transfer 

files from one device to another. And with the rise of the internet, file sharing has become 

even more accessible.

5. Simulation tools

Seeing your models in 3D has a lot of benefits. It lets you pick on minute details that you tend 

to overlook in 2D models. Likewise, you have a better and realistic picture of how your 

concept will look once it is turned into reality. Most importantly, you can simulate the 

different conditions or situations in your layouts through CAD software.

While not all solutions in the CAD software list have simulation tools, this is one feature that 

you need to look out for. This allows you to test your designs before you can start building 

them to make sure everything is in working order. Likewise, it reduces chances of 

encountering issues and setbacks with your layouts in the long run.

 2.2   2-D DRAWINGS, 3-D MODELS IN CAD PROCESSES

2.2.1 Two-Dimensional CAD

2D CAD models are what most of us are familiar with. These models are flat, two-

dimensional drawings that provide overall dimensions, layouts, and information needed to 

reproduce or build the subject. Examples of these types of drawings are found in a variety of 

industries, including aerospace, architecture, automotive, cartography, civil engineering, 

interior design, landscaping, and even fashion. 2D drawing means It has length and width. 

Three-dimensional object describes a number of two-dimensional objects is called 2D 

drawing.

AutoCAD can be start by either of the following method 

 Double click on the AutoCAD icon or 

 Right click on Auto cad icon on the desktop then select open from the option we find. 

Or 

 Selecting it from start menu, then program, Autodesk, click AutoCAD 2007 etc.,

A. Graphic Window
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                                                     Figure 2.1 Graphic Window

B. Visual Reference 

The method we just used to create the freehand sketch is known as the interactive method, 

where we use the cursor to specify locations on the screen. This method is perhaps the fastest 

way to specify locations on the screen. However, it is rather difficult to try to create a line of 
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a specific length by watching the displayed coordinates. It would be helpful to know what 

one inch or one meter looks like on the screen while we are creating entities. AutoCAD® 

2007 provides us with many tools to aid the construction of our designs. We will use the 

GRID and SNAP options to get a visual reference as to the size of objects and learn to restrict 

the movement of the cursor to a set increment on the screen. The Status Bar area is located at 

the bottom of the AutoCAD® drawing screen. The words SNAP, GRID, ORTHO, POLAR, 

OSNAP, OTRACK, DUCS, LWT and MODEL appearing to the right of the coordinates are 

buttons that we can left-click to turn these special options ON and OFF.

Command Window: - is where you enter commands by typing and where AutoCAD   

displays prompt and messages Executing commands:

-To execute Auto Cad commands, use one of the following 

 Select a corresponding tool icon from one of the tool bars or 

 choose an item from pull dawn menu bar or 

 Type the command at the command prompt.
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Drawing limits can be done by 

 Write the word `limits ` on command line ------ enter.

 Specify lower left corner 0,0 ------------ enter.

 Specify upper right corner 21 0,297 ------------ enter.

 Write Z for zoom ------------ enter.

 Write A for all------------ enter.

 Right click on grids, and click on setting -adjust snap space and grid space 10 each of 

them

  Finally click ok. Now you are ready to draw any picture 

C. Construction of 2D drawings using coordinate systems
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D. 2D drawing can be drawn either one of the following four method 

1.Direct Entry methods: - 

 It is Used to draw only vertical and horizontal line.

 Give Distance (Length) of the line then show direction. Or distance + direction 

Procedure: - 

 Select Line from Draw Menu bar Or Draw Tool Bar

 Click At Any Point on The Graphic Window.

 Show The Direction and Write the Dimension. Then Enter finally.

   Example: -. Practice to draw the figure given below with this method

                           

Fig 2.2 2D drawing

2.Polar coordinate system:

 it is used to draw vertical, horizontal and inclined line.

 It is length +angle 

That is      @ Length < angle 

Exercise: - write the steps and draw the figure given below.

1. To draw AB        @ 35<0   enter key

2. To draw BF         @ 35 <60 enter key -

3. ---------------

4. ----------------
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5. ------------------–

6. To draw EA @ 35 <360 enter key                        -

                                                                                                                       

       3. Rectangular or relative coordinate system: - 

It Can be given by @x, y which means @and any number x and y

  Exercise: - write the steps and draw the figure given below using this method 

1. To draw line AB @ 0,57 enter 

2. To draw line BC@ 57,63 enter 

3. To draw line CD @ 

4. To draw line EF @

5. To draw line FG @

6. To draw line GH @

4. Absolute coordinate system

It is drawn by x, y co-ordinate system only that is (x, y)

1. TO draw AB use 0,106

2.  TO draw BC, use 106,49

3. TO draw CD, use 106,0

4. TO draw DA use 0,0

5. close -enter

2.2.2 Command of drawing tool bar
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A. Draw command

1) LINE   COMMAND: - it helps to draw any figure you like.

 TO activate line: - select line from draw tool bar 

o Or Select line from draw menu bar

o Or write line on command line 

2) CIRCLE COMAND; - help to draw any circle

                           TO activate circle: -

 Select circle from draw tool bar 

 Or select circle from draw menu bar

 Or write circle on command line 

 Specify center point 

 Write `d` or` r`` for diameter or radius you like to do 

 Specify diameter or radius circle  

 POLYGON COMMAND 

 Select POLYGON from draw tool bar 

 Or Select POLYGON from draw menu bar

 Or write POL   on command line

 Enter number of sides                                                                                                

 Specify center of polygon 

 Enter an option circumscribed about circle or inscribed in circle (I) enter                                                                                                                             

Specify radius of circle e.g., 30   then right click or enter 

RECTANGLE COMMAND

 Select RECTANGLE from draw tool bar 

 Or Select RECTANGLE from draw menu bar

 Or write REC on command line

 SPECIFY first point by click some where you 

like.

 Write ` dim `   for the value of dimension then right click or enter 
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 Specify the length    rectangle e.g., 30mm

 Specify the width of the rectangle e.g. 20mm

4. Arc Command

o Select arc from draw menu bar

o Select one of the methods Examples, Start - Center -End then enter. 

Hatching command

 Select section from modify menu or 

 Select section from tool bar menu or

 Type section on command line. -- enter key

 Select gradient from draw dialog box - Right click or enter key 

 Specify pick point 

 Locate (pick) the internal part 

 Right click – enter then ok 

E.g., Draw and hatch the given figure below
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Fig 2.3 Hatching

B. Modify toolbars

 Erase command: -

 used to delete the object or line 

Procedure: -

 Select the Erase command from tool bar menu or

 Select Erase from tool modify menu or

 Type Erase on command line --. Enter key 

 Select the object or line to be clean 

 Then Right click or enter 

Trim command 

 Select trim from modify menu or 

 Select trim from tool bar menu or

 Type trim on command line --. enter key

 Select the object (cutting plane).

 Right click or enter key 

 Click on the line to be trim

o Or

 Select trim command

 Select the whole object right click

 Click on the line to be trim

Copy command
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 Select copy from modify menu or 

 Select copy from tool bar menu or

 Type copy on command line --. enter key

 Select the object 

 Right click or enter key 

 Specify base point 

 Finally locate or give the distance enter key 

Do one more exercise 

Move command

 Select move from modify menu or 

 Select move from tool bar menu or

 Type moves on command line ----. enter key

 Select the object by widow box- Right click or enter key 

 Specify base point 

 Finally locate or give the distance enter key

Fillets command 

 Select fillet from modify menu or 

 Select fillet from tool bar menu or

 Type fillet on command line --. enter key

 Specify radius of fillet ---R— then enter key.

 Type the number you need e.g. 25 enter key

 Select the first line and then the second line 

Rotate command 

 Select rotate from modify menu or 

 Select rotate from tool bar menu or

 Type rotates on command line ---. enter key

 Select the object by widow box- Right click or enter key 

 Specify base point of the given figure

 Specify angle of rotation ---- e g. 15 0   then enter key

N.B Practice the commands by drawing closed wrench given below  
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Chamfer command  

 Select chamfer from modify menu or 

 Select chamfer from tool bar menu or

 Type chamfer on command line--- enter key.

 Type A (angle) Right click or enter key 

 Specify length of chamfer ---- e.g.  2.5 enter key

 Specify chamfer angle ---- e.g.  450 enter key

E.g., Draw and practice the given figure below (use rectangle command)

Mirror command 

 Select mirror from modify menu or 

 Select mirror from tool bar menu or

 Type mirror on command line. --- enter key

 Select the object by widow box- Right click or enter key 

 Specify base point 

 Finally locate or give the distance enter key

E.g.  practice the given drawing below for Mirror command 

Array command 
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 Select Array from modify menu or 

 Select Array from tool bar menu or

 Type Array on command line --. enter key

 Pick “polar array “on plane box -- enter key

 Specify no of items—e.g.  4 

 Select pick center point 

 Locate center circles 

 Click on select the object then ok

 E.g., Draw and practice the given figure below.

ARRAY: This creates multiple copies of objects in pattern. Arrays are three types.

a) Rectangular Array b) Path Array c) Polar Array

Rectangular Array: In this, the object is arranged in an array of rows and columns. At the 

command prompt: type ARRAYRECT or select the option from MODIFY toolbar. It asks 

you to select objects. Select the object and press enter. By default, it shows an array of 3 rows 

and 4 columns. The no. of rows and columns can be changed by selecting the Count.

Polar Array: In this, an object is arranged in a circular shape. At the command prompt: type 

ARRAYPOLAR or select the option from MODIFY toolbar. Then select object to be 

arrayed. Then select the center point of array. By default, a six items array is created. The No. 

of items can be changed by selecting the Items option. Angle between the two items can also 

be changed.

The following figures are two-dimensional drawing. Then perform this 2D drawing by cad 

2007 or other at the end of UC.
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Fig 2.3 D drawing review Quetions

2.2.3   3D models in CAD processes

3D CAD models have uses similar to those of 2D CAD models. Then why the distinction? A 

three-dimensional CAD model provides greater detail about the individual components and 

assemblies of a physical object. In other words, 3D models show you how something fits 

together and operates rather than just how big it is and its overall shape

Conceptualization: A model made for design is known as parametric. It means that every 

dimension, relation, feature, and step defining the model is shown on history-based 

management. Regular drafting is a tedious and rigid method. Prone to many errors it hinders 

the process quality and final result. Everything that took so much trouble in the past now is 

solvable automatically in few steps. As a clear case, technical drawings can be quickly 

generated from a model. CAD software not only deals efficiently with models, but with entire 

assemblies and complex surface geometries that would otherwise need outstanding drafting 

expertise to draw manually. 

Visualization

https://www.cadcam.org/about/what-is-cad-cam/
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CAD interfaces offer a clear view of how the design should look from every angle and scale. 

Having your model on a 3D space helps the designer have a clear idea of the final result. To 

make it even better, visualization tools go beyond just that. It’s possible even to control 

transparency and wireframe views, letting you seeing hidden edges. 

You can even create scenes with photo-realistic rendering, which is used for presenting your 

project for marketing goals like funding and sales. 

Isometric Drawing

 To do this drawing apply the following.

 Limit your drawing area first

 Right click on grid

 Select setting 

 Select isometric snap Then ok.

 Finally, you will find the curser angle is changed.

 In this type of drawing even inclined angle is drawn by 300, 1500, 2100, 3300, 

and vertical line is drawn by 900 and 2700 degrees 

 To draw Isometric drawing 

 Select ellipsis

 Type I and enter key

 Specify center point 

 Specify the (side top/right /left) by function key (F5)

 Specify the radius 

https://computersciencewiki.org/index.php/Three-dimensional_use_of_visualization
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Exercise the following 3D drawing
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Fig.2.4 3D drawing Review questions 

2.3 PERIPHERAL EQUIPMENT AND SOFTWARE PROGRAMS COMPATIBILITY

2.3.1 Peripheral Equipment

Peripheral equipment refers to non-essential devices or equipment connected to a host 

computer, usually externally, in order to extend its capabilities. Peripheral equipment may not 

be essential to the computer's operation, but it's often needed in order for a user to interact 

with the computer.

What are examples of peripheral equipment?

Computer peripheral device

 Monitor.

 Keyboard.

 Mouse.

 Trackball.

 Touchpad.

 Pointing stick.

 Joystick.

 Light pen

2.3.2 Software Programs Compatibility
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Compatibility is the capacity for two systems to work together without having to be 

altered to do so. Compatible software applications use the same data formats. For 

example, if word processor applications are compatible, the user should be able to 

open their document files in either product

Self-Check 2



Version -1Page 40 of 66 Ministry of Labor and 
Skills

Author/Copyright

Preform CAD operation

August, 2022

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page:

I. choose the correct answer for given alternative (5 point each)

1, Which one of the following is the capacity for two systems to work together without 

having to be altered to do so.

        A, production specification B), application specification C) Compatibility

2. Which one of the following is no longer an extra aid, but a must for the design process

A,) Performance specifications B), Computer-Aided Design (CAD) C) Application 

Specification

3. Which one of the following that provide overall dimensions, layouts, and information 

needed to reproduce or build the subject.

     A) Two-dimensional drawings B,) 3D specification    C,) Application drawing

II.   Answer the following questions (3point each)

1. Sketch 2D drawing that appear in figure Figure A by using cad.

Figure A

2. Sketch 3D drawing that appear in figure Figure (B) by using cad.



Version -1Page 41 of 66 Ministry of Labor and 
Skills

Author/Copyright

Preform CAD operation

August, 2022

Figure A

III. Say true or false (5 point each)

1. Smart or automated tools are one of the general features of CAD software.

2. CAD software has all but replaced the T-squares and protractors used by the designers of 

yesterday in a process known as manual drafting.

Operation Title: Created 3d Cad Drawings 

Instruction: follow the following instruction to make Created 3D CAD drawings

Purpose: To make 3D CAD drawings from a given drawings by following cad procedures.

Required tools and equipment: AutoCAD 2007/2020 /2019 etc.

Precautions:

 Understand the given drawing

 Adjust properly necessary command tool on graphic window.

Steps: 

Step1. Set the limits of the drawing screen

Step 2. Open graphic window

Step 3. Put ortho on where ever necessary. Use the required modify tool bar commands like 

trim,   

Step 4. Adjust command tool.

Step 5. Construct 2D drawing.
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Step 6. Select the extrude command from the 'Home' tab of the AutoCAD ribbon, pick the 

3D polyline from the previous step and then type 90 as the height of extrusion to create a 3D 

solid

Fig 2.4 3D CAD drawings
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LAP Test Two-Dimensional Drawing

Name: __________________________                                Date: ____________

Time started: ____________________           Time finished: _______________

Instruction I: Given necessary command tools and software you are required to perform the 

following tasks within 2 hours.

. You are required to do the following activities as required in the problem

Task 1: Two-dimensional drawing
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Unit three: Software and Set Up for Drawing Work

This learning unit is developed to provide the trainees the necessary information regarding the 

following content coverage and topics:

 Opening CAD software 

 Organizational and software templates 

 Symbols, codes and standards

This unit will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to:

  Opening CAD software 

 Identifying organizational and software templates 

 Identifying symbols, codes and standards

 

3.1 OPENING CAD SOFTWARE

Opens CAD is an open-source parametric software, that can be used to create 2D designs, 

and 3D models. It is a great tool to make 3D objects designed for additive manufacturing. 

While using Opens CAD, you can't modify directly with your mouse the CAD model that is 

in the viewer

AutoCAD can be start by either of the following method 

 Double click on the AutoCAD icon or 

 Right click on Auto cad icon on the desktop then select open from the option we find. 

Or 

 Selecting it from start menu, then program, Autodesk, click AutoCAD 2007 etc.,

Graphic Window



Version -1Page 45 of 66 Ministry of Labor and 
Skills

Author/Copyright

Preform CAD operation

August, 2022

Figure 3.1 Graphic window

Command Window: - is where you enter commands by typing and where AutoCAD   

displays prompt and messages Executing commands:

-To execute Auto Cad commands, use one of the following 

 Select a corresponding tool icon from one of the tool bars or 
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 choose an item from pull dawn menu bar or 

 Type the command at the command prompt.

Drawing limits can be done by 

 Write the word `limits ` on command line ------ enter.

 Specify lower left corner 0,0 ------------ enter.

 Specify upper right corner 21 0,297 ------------ enter.

 Write Z for zoom ------------ enter.

 Write A for all------------ enter.

 Right click on grids, and click on setting -adjust snap space and grid space 10 each of 

them

  Finally click ok. Now you are ready to draw any picture 

3.2 ORGANIZATIONAL AND SOFTWARE TEMPLATES

Templates in AutoCAD is a baseline for your work. It helps you to easily create a future 

drawing without initial settings. Using templates reduces work time, reduces the chance to 

make mistakes in settings and makes uniformity to every work in a single project

A drawing template enables you to create exact circles, squares, lines, arcs, and more without 

reaching for a compass, ruler, or protractor. It's a necessary tool for executing clean-lined 

blueprints, sketches that demand precision, or crisp compositions for bullet journals

3.3 SYMBOLS, CODES AND STANDARDS

Some Basic Definitions

In AutoCAD, symbols and details that you insert into drawings are called blocks. A block is a 

collection of geometric and text objects plus other data that are combined into a single named 

object. The following are some examples of a variety of blocks at different scales. Symbols 

can be inserted in text using one of the following methods: In the In-Place Text Editor, right-

click and click Symbol

Line-thickness

Thickness for pens and plot: 0.13 mm Gray, 0.18 mm Red, 0.25 mm White, 0.35 

mm Yellow, 0.50 mm Magenta, 0.70 mm Blue, 1.00 mm Green. In AutoCAD usually parts to 

be printed in black are drawn in 1 to 7 basic colors. Color layer: Green-Center, Magenta-

Measure of length and Blue-Hidden.

https://en.wikipedia.org/wiki/AutoCAD
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Description
Line thickness in 

mm
Color Codes

Out Line 0.20 or 0.25
White, Cyan, Yellow, 

Blue

Hidden Line 0.00 or 0.05 Blue, Gray, 241

Center Line 0.10 or 0.15 Green, Red, Blue

Note 0.18 or 0.20
White, Cyan, Green, 

41

Thin Line 0.00 or 0.05 Gray, 08, 111

Reference Line 0.000 Magenta, Gray

Hatch Line 0.000
Magenta, Green, 

Gray, red

Color-9 to 256 0.000

Dimension line

Leader Line with 

Arrows
0.000

Gray Color-9, or 8, 

Red
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Text 0.18 or 0.20 Cyan, Green

Text and dimension

Heights: 2.5 mm, 3.5 mm, 5.0 mm, 7.0 mm (stroke thickness (line weight) should be 0.1 of 

the character height). Font styles: "Romans.shx - Romantic Simplex", "ISOCPEUR.ttf". 

Exceptional use of screen fonts (arial, Times New Roman etc.).

Scales

 2:1, 20:1, 200:1 ...

 1:1, 1:10, 1:100 .1|8}} in = 1 ft

 3⁄16 in = 1 ft

 1⁄4 in = 1 ft

 3⁄8 in = 1 ft

 1⁄2 in = 1 ft

 3⁄4 in = 1 ft

 1 in = 1 ft

 1+1⁄2 in = 1 ft

 3 in = 1 ft (QUARTER SCALE)

 6 in = 1 ft (HALF SCALE)

 1 ft = 1 ft (FULL SCALE)
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Self-Check -3

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page:

I. choose the correct answer for given alternative (5 point each)

1. Which one of the following is an open-source parametric software, that can be used to 

create 2D designs, and 3D models

        A, Opens CAD B), application CAM C) 2D

2. Which one of the following is a collection of geometric and text objects plus other data that 

are combined into a single named object.

A,) Performance specifications B), A block (CAD) C) Application Specification

3. Which one of the following is reduces work time, reduces the chance to make mistakes in 

settings and makes uniformity to every work in a single project     A) Using templates B,) 3D 

specification    C,) Application drawing
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Unit Four. Produce Basic Drawing Element

This learning unit is developed to provide the trainees the necessary information regarding the 

following content coverage and topics:

 Basic drawing elements 

 Editing and transfer tools and methods 

 Dimensions, text and symbols

 Importing and exporting files

 Generating different views and perspectives

This unit will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to:

  Use CAD functions to produce basic drawing elements 

 Use editing and transfer tools and methods to modify drawing elements 

 Apply dimensions, text and symbols to drawing elements 

 Perform Import and export files into/out of working space 

 Identify different views and perspectives 

4.1 Basic drawing elements 

The most common elements include line, shape, texture, form, space, color and value, with 

the additions of mark making, materiality, Points, angles, circles, arcs, planes, figures and 

solids, Squares, rectangles and triangles, Bisected lines and dividing lines Polygon, ellipse, 

spline, dimension and hatch. It is merged (described detail 2D ON the above) on 2.2.1 2D

    4.2 EDITING AND TRANSFER TOOLS AND METHODS

Essential Commands of Modify Panel in AutoCAD

 Move (M+Enter)

 Rotate (RO+Enter)
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 Copy (CO+Enter)

 Mirror (M+Enter)

 Stretch.

 Scale (SC+Enter)

 Trim (TR+Enter)

 Extend (EX+Enter)

Description. When the file specified by the File parameter names an existing file, the edit 

command copies it to a buffer and displays the number of lines and characters in it. It then 

displays a: (colon) prompt to show that it is ready to read subcommands from standard input

    The Transfer Tool feature transfers features lists for the packages that you select. 

To copy a package, perform the following steps: Select the packages to copy in the table 

under the Packages heading. Select the checkbox in the table header to select all of the 

packages from the remote server
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4.3. APPLYING DIMENSIONS, TEXT AND SYMBOLS
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A linear dimension can only be drawn horizontally or vertically. An aligned dimension, on 

the other hand, can be drawn at every angle. The dimension line will thus run parallel to the 

dimension starting and end point.

 First specify the text height before any dimensioning is taken place 

 To do this click format ---text style ---give text height--- apply and close 

4.3.1. Linear dimensioning:

 Help for vertical and horizontal line dimensioning  

 Select leaner from dimensioned menu

 Or select leaner from dimensioned tool bar 

 Or write linear on command line 

 Specify first extension line (origin)

 Specify first extension   line

4.3.2 Aligned dimensioning: -

 Used only for inclined object 

 Select Aligned from dimension menu

 Or Select Aligned from dimension tool bar 

 Or Write Aligned on command line 

 Specify first extension line (origin)

 Specify first extension line 

.
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N.B. Practice all the dim. Style by yourself!!

Dimension editing 

 Select Dimension editing from dimension task bar 

 Select the option (oblique, New, rotate, home)

 Write new (N) – enter key

 Cancel (< >) from the dialog box – then OK

 Right click then enter key

exercise: -

Object snap tool bar

 To set running object snaps 

 Click Tools menu » Drafting Settings. 

 In the Drafting Settings dialog box, Object Snap tab, select the object snaps you want 

to use. 

 E.g., Select all Click OK. 

Entering Text 

Or to specify a text style when you create single-line text 

Click Draw menu » Text » Single Line Text. 

Enter s (Style).  Or text height 
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THEN OK

4.4. IMPORTING AND EXPORTING FILES

The Export command creates a CAD-compatible DXF or DWG file from the current 

AGi32 job file. While other CAD programs can use the CAD files created from AGi32, 

the format is constructed specifically to standards. The exported CAD file consists of 

layers containing drawing entities and text representing all of the lighting specific data 

in the  AGi32 files. These files can be easily merged into existing drawings.

     Please note that the process of creating a CAD file simply produces an additional file 

formatted to the selected CAD format - DWG or DXF. Your original AGi32 file is not 

altered in any way. Exporting a CAD file is not a replacement to saving your original 

AGi32 file. You should always save your AGi32 file with any current changes. A CAD 

file has no lighting or surface information inherent inside, and lighting metrics present in 

a CAD file are not modifiable in AGi32. Its purpose is to combine with other existing 

CAD drawings for presentation only 

Saving in AutoCAD File Format (DWG/DXF)

1. On [File] menu, click [Export] - [Export to DXF File] / [Export to DWG File]. 

[Export] dialog box will be displayed.

2. Select a saving location.

3. Enter a file name in [File Name] box.

4. Click [Save] button. The drawing created in RootPro CAD will be saved as an 

AutoCAD drawing file.

To export and import tool palettes in AutoCAD

1. On any drawing, enter CUSTOMIZE to open the Customize window.

2. Right-click a tool palette and choose Export.

3. Choose a location to save the.

4. On the target system (or on the target program), enter the CUSTOMIZE command.

5. Right-click on any palette name and choose Import

4.5. GENERATING DIFFERENT VIEWS AND PERSPECTIVES
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perspective in CAD: AutoCAD allows to switch to a perspective (perspective view of a 

3D scene) in several ways: The DVIEW command with the Distance option (resp. Points 

and Distance) The 3DORBIT command, right-click: 

To Display a Preset 3D View

1. Click View tab Views panel View Manager. Find. The View tab is not displayed by 

default, so an alternative method is to enter VIEW at the Command prompt. You can 

also employ the View Cube in the top-right corner of the drawing area.

2. Select a preset view (Top, Bottom, Left, and so on

Select predefined standard orthographic and isometric views by name or description.

A quick way to set a view is to choose one of the predefined 3D views. You can select 

predefined standard orthographic and isometric views by name or description. These views 

represent commonly used options: Top, Bottom, Front, Left, Right, and Back. In addition, 

you can set views from isometric options: SW (southwest) Isometric, SE (southeast) 

Isometric, NE (northeast) Isometric, and NW (northwest) Isometric. To understand how the 

isometric views work, imagine you are looking down at the top of a box. If you move toward 

the lower-left corner of the box, you are viewing the box from the SW Isometric View. If you 

move toward the upper-right corner of the box, you are viewing it from NE Isometric View.

To Choose a Preset View
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Self-Check -4

Self-Check -4 Written Test

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page:

I. choose the correct answer for given alternative (5 point each)

1.Which one of the following is consists of layers containing drawing entities and text 

representing all of the lighting specific data in the AGi32 files

        A, Opens CAD B), The exported CAD file, C) 2D CAD operation

2. Which one of the following is a linear dimension can only be drawn horizontally or 

vertically.

A,) Performance specifications B), A linear dimension C) An aligned dimension

3. Which one of the following is an aligned dimension, on the other hand, can be drawn at 

every angle     A) Using compass B,) 3D specification    C,) An aligned dimension



Version -1Page 60 of 66 Ministry of Labor and 
Skills

Author/Copyright

Preform CAD operation

August, 2022

Unit five. Complete CAD operations

This learning unit is developed to provide the trainees the necessary information regarding the 

following content coverage and topics:

 Saving drawing elements 

 Printing drawing elements 

This unit will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to:

 Perform Saved and filed drawing elements according to organizational 

procedures 

 Perform Print and evaluate drawing elements presentations 

3.1 SAVING DRAWING ELEMENTS

Save As

1. Go to the File menu and select Save As. The Save Drawing dialog box opens:

2. Browse for the location where you wish to save your drawing. ...

3. You can also choose how to view your files by clicking Choose view in the top right 

corner:

4. Name/rename the drawing in the File name field.
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5. Click the Save button.
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 5.2. PRINTING DRAWING ELEMENTS

Plotting (printing) Drawing

Once your page setup has been created, you are ready to print your drawings.

From the Ribbon Output tab > Plot panel, click the Plot button.

Command line: To start the Plot tool from the command line, type “PLOT” and press 

[Enter].

From the Page Setup list, select your newly created page setup and click OK to plot using 

the selected settings.

ADDITIONAL OPTIONS

There are some additional settings in the Plot dialog box that aren’t 
available in the Page Setup dialog box.
Initially the Plot model will only show a few of the options. In the bottom 
right corner, click the More Options button to show the full properties.
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Additional tools can be found in the Plot options section and include:
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Plot in background, with this option un-ticked, the plot progress will display when you 

click OK. If this is ticked the progress will be hidden and you will be able to continue 

working in AutoCAD.

Plot stamp on will place a plot stamp on the drawing. Ticking this option will show a button 

to configure the plot stamp.
                                     

Clicking the button will show the Plot Stamp dialog where you can choose information, 

including Date and Time, drawing name and Plot scale, to be printed on the drawing.

Save changes to layout If changes are made to the layout such as changing the printer, the 

changes will be saved to the Page Setup.

  

PRINT FORMATS

During the process of a construction project, you will need to print hard-copy 

drawings, whether for planning consent, issuing drawings to other members of the design 

team, or when requesting information. More commonly drawings are issued as digital copies 

via e-mail or a web portal. Issuing the Drawing file as an editable format is not recommended 

because the file can be modified by the recipient and, when printed, may not display as 

intended. By default, AutoCAD includes printers for four non-editable formats: DWF6 

plot creates an Autodesk Drawing Web Format (.DWF) file. This is a vector format 

developed by Autodesk to print non-editable files in a lightweight format. A free viewer from 

Autodesk can be used to view these files. The free viewer is installed by default when 

installing AutoCAD.

DWG to PDF creates an Adobe Portable Document Format (.PDF). This is an 

extremely common format used by most industries to issue non-editable files. A free viewer 

from Adobe can be used to view these files and is pre-installed on many PCs and laptops.

Publish To Web JPG will create a JPG image file. The file is a raster format which, when 

zooming in, will degrade in quality. This format is not recommended for issuing drawings but 

can be useful for adding images to reports.

Publish To Web PNG will create a PNG image file. Similar to JPG, PNG is a raster 

format but is un-compressed and designed for exchanging images on the web. This is also not 

recommended for issuing drawings or using within a printing system that requires CMYK 

colours.
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Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page:

I. Perform 3D drawing that listed below in figure D

Figure D

LAP Test: Draw 3D drawing listed below in figure F by using cad and Save in the desk top 

Name: __________________________                                Date: ____________

Time started: ____________________           Time finished: _______________

Instruction I: Given necessary templates, tools and materials you are required to perform the 

following tasks within 1 hours.

Task 1
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Figure F


